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Knowledge Base Article: Article 212
How to solve a problem for Click&DECIDE Cubes?
Date: September 16th, 2014

Problem:
| want to create or run a Cube with Click&DECIDE Buider or run a Cube through the Web Portal and | get some errors.

Explanation:

The reasons could be:

1. The Microsoft Web Component 2003 has not been installed or not successfully, or you are running Internet Explorer
64-bit on a Windows 64-bit machine.

2. The OWC11.DLL has not been registered.

3. The Microsoft OLE DB Provider for Analysis Services is not the one expected, depending on your MS SQL Server
version (2000 or 2005). If you have MS SQL Server 2005, you also need the MSXML 6.0 component.

4. You have a problem with the Microsoft Text ODBC driver against CSV files. See page 4 How to Debug a Cube.

Solution:

1. Uninstall and reinstall the Microsoft Web Component 2003 from the Click&DECIDE Setup directory:
C:\Program Files\Click and DECiIDE\SetupFiles\setup\ISSetupPrerequisites\Microsoft Office 2003 Web Components
or from the Microsoft Web Site if you get this message when running a cube through the Web Portal:

This page requires the Microsoft Office Webh Components. Click here to install Microsoft Ofice Weh Components..

Click the link to get the file download page:
http://www.microsoft.com/downloads/en/details.aspx?FamilylD=7287252c-402e-4f72-97a5-
e0fd290d4b76&DisplayLang=en

And select the required language, and then install the owc11.exe program.
If you are under a Windows 64-bit, please use Internet Explorer 32-bit.

2. The Microsoft Web Component 2003 has been installed but you still get errors when trying to run or create a cube.
Try to reg|ster the OWC11.DLL component as follow:
Open a Command Prompt window (Run as Adminisrator)
- Go to the C:\Program Files\Common Files\microsoft shared\Web Components\11 directory
- Enter the command: regsvr32 "C:\Program Files\Common Files\microsoft shared\Web
Components\11\owc11.dll" and press <Enter>
- You should get the message:

Regiurdl

@ DlIRegisterServer in owell.dll succeeded.

k- -

3. The Microsoft OLE DB Provider for Analysis Services is not the one expected, depending on your MS SQL Server
version (2000 or 2005). The requirements are the following:
- Against MS SQL Server 2000, the client machine needs to have Microsoft OLE DB Provider for
Analysis Services 8.0
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Against MS SQL Server 2005, the client machine needs to have Microsoft OLE DB Provider for
Analysis Services 9.0 and MSXML 6.0.

= g

J&Te

S ._."_—’ |:l

—

Click&DECIDE NSI & BAI | KBA

If you have a client PC that want to create a cube from Analysis Services against a server having MS SQL
Server 2005, and if the client PC doesn’t have the MSXML 6.0 and Microsoft OLE DB Provider for Analysis
Services 9.0, you will get an error message when connecting to the database: Test connection failed because
of an error in initializing provider. Object not found.

Even if you are not running a cube against an Analysis Services database, follow the next steps to display an
additional Tab in the Click&DECIDE Buidler command File> New> Cube allowing to know what is the
installed version:

How to display this additional Tab?

Open REGEDIT
Go to the following key:

HKEY_CURRENT_USER\Software\DataSet\DataSelect Vision\Settings
On the right window, add a DWORD (32-bit) key named Master
Change the value to 1 and validate

ﬁﬂegistr}f Editor EI@
Eile Edit Miew Favorites Help
4 Dataket = || Mare Type Data
b - Click and DECIDE Administration Manager E_?J(Default) REG.SZ (value not set
b - Click and DEC?DE Chart Designer . . E!']Lang REG_S7 .
L ikt DECDE W e || ELitTobesDispay o DWORY DO )
b 1 dTcubdraddre .?ﬁ]Repc-r‘t Fuler REG_DWRD 000000001 1y
b dTunrt — .ltl'g']Report Squaring REG_DWWORD 000000000 {07
4. | DataSelect Vision 1 i-i%]SpIashInfos REG_DWWORD Q00000001 (13
| Debug 3 .‘g’;'_‘;]\-’iEWZDDmed REG_DWRD 000000000 (0
| Erwironment || S| Master REG_DWWORD M=00000001 (13
| Recent File List
e L) Seftings
- | State
o | Workspace
----- ) DataSet Server Administrator
----- , General
w0 Model i
1 | . mn | » 4 | T b

ComputertHKEY_CURRENT_USER\SofturaretData SetiDataSelect Wision'Settings
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Then, from Click&DECIDE Builder, the Provider Tab will be displayed when starting to connect to an
Analysis Services, even if you do not have such database.

Click the command File> New> Cube

Mews Cube

sl

)

Cube from Click and DEElDE Builder Quer

Cube from Analys

[ Ok ] [ Cancel

Select “Cube from Analysis Services” and you will get this dialog box with an additional Tab named
“Provider”, select this Provider Tab to check the version of the Microsoft OLE DB Provider for Analysis
Services 9.0 and/or Microsoft OLE DB Provider for OLAP Services 8.0:
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£ Data Link Properties [mE3m]

Frovider | Connection | Advanced | & |

Select the data vou want bo connect b

OLE DB Provider(z) it

Microzoft Jet 4.0 OLE DB Prowvider
Microsoft Office 12.0 Access Database Engine OLE DB Pro

ticrozoft OLE DE Provider for Analysiz Se

ticrozoft OLE DE Provider For Data Mining Services
Microzoft OLE DE Provider for Indexing Service
Microzoft OLE DB Provider for QDBC Drivers

m

Microzoft OLE DB Provider for OLAF Services 8.0
Microzoft OLE DB Provider for Oracle

Microzoft OLE DB Provider for Search

Microsoft OLE DB Provider for SOL Server
ticrozoft OLE DE Simple Provider

k50 ataShape
OLE DB Provider for Microzaft Directon) Services -
1 | 1] [ 3

F, H Cancel H Help ]

If the Microsoft OLE DB Provider for Analysis Services 9.0 is missing, here is the way to install it:
Steps 1: First install the MSXML 6.0 using the link:

http://www.microsoft.com/downloads/details.aspx?Familyld=d21c292c-368b-4cel-9dab-
3e9827b70604&displaylang=en

Steps 2: Then install the Microsoft OLE DB Provider for Analysis Services 9.0: SQL Server 2005 Feature
Pack from February 2007

http://www.microsoft.com/downloads/details.aspx?familyid=50B97994-8453-4998-8226-
FA42EC403D17&displaylang=en

Click Download file below and select the SQLServer2005_ASOLEDB9.msi
Microsoft SQL Server 2005 Analysis Services 9.0 OLE DB Provider

The Analysis Services 9.0 OLE DB Provider is a COM component that software developers can use to create
client-side applications that browse metadata and query data stored in Microsoft SQL Server 2005 Analysis
Services. This provider implements both the OLE DB specification and the specification’s extensions for
online analytical processing (OLAP) and data mining.

Note: Microsoft SQL Server 2005 Analysis Services 9.0 OLE DB Provider requires Microsoft Core XML
Services (MSXML) 6.0, also available on this page.

Audience(s): Customer, Partner, Developer

X86 Package (SQLServer2005_ASOLEDB9.msi) - 12160 KB
X64 Package (SQLServer2005_ASOLEDB9_x64.msi) - 27981 KB
IA64 Package (SQLServer2005_ASOLEDB9 ia64.msi) - 34700 KB
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Cube Debug:

Sometimes the Click&DECIDE Support could ask you to help to debug the problem and see why and when an error
occurs when running or creating a cube. In that case, please follow the next steps:

1. Activating the Show SQL Cube option: start Click&DECIDE Builder and run the command Tools> Options>

Cube.
Sptluns E
General | Query | Cube |E~.fent kanager | License|
s Before printing or exporting a cube
Y
Dizplay a meszzage ta refresh cube data
Befresh data
Default
Dizplay the Month Mame
Default ‘Analyziz Services' Server Mame
LocalHost
I 0k, I [ Cancel ] [ Apply ] [ Help
2. Click OK

3. Create a new cube from an existing query:

HE'I.I'I.I' EUEE E

6 Cube fram Click and DECIDE Bulder Querny
L Cube from Analysis Services

I 2k, I [ Cancel

4. |If you are inside an existing Cube, click the Cube wizard icon:

File Edit View Cube Insert Tools Window Help

FH@_RIN 3T @D
= Click and Decidy -

G2 | Bz | &) %l

ﬁ!\ Cube Wizard | Cube 1 5ales by Year and by Salesman

i Opens the Cube Wizard | 2 15 B | Xy | S| | ()

spaly Lal

Dynamic Cube Sales by Year and by Salesman
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The reason is that the Show SQL Cube Option is only available when starting from the Cube wizard.

5. Select the required Dimension and Measures:

Cube Assistant - Step 2 of 2

Mame ! Type Description EIO demo_multicriteria
-1 Dimensions
Amount Float EI AREA
Area Varchar - [E sREA
Code Integer =-E SALMAME
Date TimeS5tamp {5 SALNAME
Salesman name Yarchar E‘“ DATE
=[] by Manth
E ears
E Manths
E Daps
I':'I--[nl]] Meazures
N TOTAL [Sur]

Digplay the Month Mame

< Back ” MHest » | I Finizh I [ Canicel ] [ Help
6. Click Finish
B | Parameters =0 FoR(F=
I” &rea ? (=N ndl OK
™ salesman ? IIGNORE |!J Cancel
V¥ pate? {use part of date or keywords) |2U1 1] |ﬂ]

7. Specify the parameter values if needed, then click OK
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SELECT Salesman AREA S alesman. SALMAME S ales. TOTAL [DatePart -
[dd.Salez. "DATE"LID atePartimm,S ales."DATE" ][0 ateM ame[month, Salesz. "DATE"]).
[DatePartiyy S ales "DATE")) FROM D ataSetR eport. demo. 5 ales

Salez. D ataSetR eport. demo. S alesman S alezman *"WHERE [Sales.SaL = Salezman. SaAL]
AMND [[[Salezman AREA=MNORTHMWEST' OR [Salesman AREA="SOUTH') AMD
[[Sales."DATE">="2010-01-01 00:00:00.000" AMD Sales "DATE"<="2010-12-31
23:59:55.0007)) ORDER BY' 1.2

[ Ok J[ Cancel ]

8. Make a copy of the SQL content of the above screen to be sent to the Click& DECIDE Team Support, then click
OK. If any error occurs before or after this step, make a copy of this error.

Cube Staterments

(]
PROVIDER=M50LAP DATA SOURCE=C:\Program Files\Click and DECIDESBAIDemaiweb\Click and Decide Web P
Demonstrationtrmpd00549805. cub SOURCE_DSM="PravidersMSDASGL 1 Persist Security Infa=True Extended Properties="T1SMN=DataS et Visian
C5V DefaultDir=C:\Program FileshClick and DECIDENBAINT empozy Diiverl d=27 FIL=text 4 axBufferSize=2048PageT imeout=5;"Inital Catalog=C:"Program
FileshClick and DECIDENBAINT empesy;,CREATECUBE=CREATE CUBE [demao_rulticriteria] [DIMENSION [AREA] LEVEL [&1l ARE&S] TYPE ALL. LEVEL

[AREA]L DIMENSION [SALNAME], LEVEL [4 SALNAME] TYPE ALL, LEVEL [SALMAME], DIMENSION [DATE] T¥PE TIME, HIERARCHY [by Month],
LEVEL [A)l by Marith] TYPE ALL, LEVEL [Years] TYPE YEAR OPTIONS [SORTEYKEY), LEVEL [Marths] T¥PE MONTH OPTIONS [SORTEYEEY),
LEVEL [Days] TYPE D&Y OPTIONS (SORTEYKE'Y), MEASURE [TOTAL] FUNCTION SUM TYPE DETYPE_RSINSERTINTO=INSERT INTO
[demo_mulicsiteria] [[SFREA] [SREA] [SALNAME] [SALNAME], Measures [TOTAL] [DATE] by Month].[Days], [DATEL[by Morth] [MonthsL KEY, [DATE]
[y Month] [Months]. MAME, [DATE . [by Morth].[¥ears]) DPTIONS PASSTHROUGH SELECT T1. 4ea’,T1. Galesman

name, 71, Amount. T1.'F_0358A820_024C9500_0°T1.'F_03584820_034C9600_1".T1.'F_03554520_034C9600_2", T1.F_03584820_034CI600_3
FROM d7d400552425. cov T1

Disable this check box

9. In the above screen make a copy of the SQL content to be sent to the Click&DECIDE Team Support and
uncheck the “Delete Temporary File” option. Then click OK. If any error occurs before or after this step, make a
copy of this error.

10. If no error occurs, you should get the cube correctly.

11. If an error occurs, make sure to copy and paste any text or screen that can help the Team Support.

12. If the Team Support asks you to get the Temporary Files, do the following:

- Goto the C:\Program Files\Click and DECIDE\BANTempcsv directory
- Make a copy of the csv files and ini files and send them to Click&DECIDE Support.

(== =

@Qﬂ .« Click and DECIDE » BAl » Tempcsw v | 44 || Search 2|

o

Favorite Links Mame Date modified Type Siz
—_— ] d7d281604268.c5v 10/16/2010 3:21 4M  Microsoft Office E..
5] 474400552425, c5v 10/19/2010 :26 PM  Microsoft Office E..
B Documents & | schemaini 10/19/2010 6:26 PM  Configuration Sett..
E Pictures

13. If you have a license to run Click&DECIDE Buidler and want to check the Microsoft ODBC Text driver using a
CSV file, do the following:
- Open Administration Manager
- Create a new ODBD data source: New> Data Source>, then enter a Name and select ODBC:

Contact us: E-mail: sales@clickndecide.com Tel: +33 (0)6 71 99 86 60

6
Sales Offices: 98, route de la Reine - 92100 Boulogne-Bt, France. WWW. Cl I C kn d eCId e . CO m

To contact your nearest Click&DECIDE partner, click here.



mailto:sales@clickndecide.com
http://www.clickndecide.com/

m CLiCk&DEC;DE Click&DECIDE NSI & BAI | KBA

Mew Data Source

0
Data Source Mame:

i

Test_ODBC_CSV

Data Source:

M
SOL Server
Orade

iSeries TCP/IP
DE2-UDE
opeC |
Click and DECIDE Connect

Wa Click and DECIDE Model Orade, DE2-UDE etc.)
rieg Excel d first. If this module is
not Web Service gsing file may be
displayed.

- Click OK

ODBC Interface - Setup

ADBC Data Source .

- ] Cancel

Supported Join Style

Peat
g

- ODBC Setup
@ Regular Only

() S0OLA400
) Access
) Oracle

) SOL Server

Time5tamp format

[{ts "ppnperir-dd HH: bk 55% v]

Advanced [uze carefully, ezpecially for server datazources)
M anage Schema / Hame levelz

[] Also manage Catalog level if driver supports it

[ Requires uze of field index in GROUP BY clause for
ERpIEESi0ns

[] Can uze field alias in GROUP BY clause for expressions

- Click ODBC Setup
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. ODBC Data Source Administrator

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

MName Diriver i Add...
Microsoft Excel Driver (" —
Anagrafica? Microsoft Excel Driver ("
BUGZILLA MySQL ODEC 5.1 Driver
Click and Decide to Excel Microsoft Excel Driver ("xd

data demo Microsoft Bxcel Driver ("

datademo Microsoft Bxcel Driver ("

DataSelect Server Database 1.2 Microsoft Access Driver (* i

: T_ RTINS ~ =____|_ —a P T

r An QDBC System data source stores information about how to connect to
5 the indicated data provider. A System data source is visible to all users
= an this machine, including NT services.

[ ok J[ camcel || ooy [ Hep |

- Select System DSN
- Click Add and search for the Microsoft Text Driver (*.txt; *.csv)

Create Mew Data Source E

Select a driver for which you want to set up a data source.

Mame Version a
Microsoft FoxPro VFP Driver ("d... 1.00.02.00
Microsoft QDBC for Oracle 6.00.6001.13000

Microsoft Paradox Driver (*.db ) 6.00.6001.13000
Microsoft Paradox-Treiber ("db ) &.00.6001.18000
Microsoft Text Driver (“hd; " csv) BESLEELIYRELLI]
Microsoft Text-Treiber (*bd; *.cav) 6.00.6001.13000
Microsoft Visual FoxPro Driver 1.00.02.00

(T o (L = T I | 4 nnonoonn

4| i | 3

<Back || Finish | [ Canesl

- Check the version and DLL name moving to the right
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Select a driver for which you want to set up a data source.
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ampary
icrosoft Corporation
icrosoft Corparation
icrasoft Corparation
icrosoft Corporation

File

VFPODBC.DLL

MSORCL3Z.DLL
ODBCJTI2.DLL
ODBCJTI2.DLL

Date -~

11722006
1/18/2008
141872008
141872008

icrosoft Corporation |

ODBCJTI2DLL

1/18/2008

icrosoft Corporation
icrosoft Corporation

o

1

ODBCJT32.DLL
VFFODBC.DLL

R e P Y o P T |

1/18/2008
11/2/2006

e B e W T2 ¥ T

m | »

<Bsck | Finish

J [ Cancel

- Click Finish
- Enter a Data Source Name

Data Source Name: TestCSW

Description:
Database
Dlirectony: C:Windows system 32

| Select Directory...

[¥]ilze Cument Directany:

- Uncheck Use Current Directory and click Select Directory

Contact us: E-mail: sales@clickndecide.com Tel: +33 (0)6 71 99 86 60
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e ]

File name: Folders:
= = _CIK
asc:”.cev: tab: b o \baiMtempeosy
Cancel
d7d281604268 cav = a [==2 o -
d7d400552425 cav (== PROGRAM FILES
[~ CLICK AND DECID
[=> BAI
= TEMPCSY
Save file as tvpe: Drives:
[Tﬁd Files (*.asc;*.cav;”. v] Hc - Metworlc...

- Search for the path by default C:\Program Files\Click and DECIiDE\BANTempcsv

Data Source Name: TestCSWY QK

Description:
Database
Directony: C:hC MBAMTEMPCSY

Use Cument Directory

- Click OK
- This new Data Source Name should appear in the System DSN Tab:
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P =

; QDBC Data Source Administrator E
User DSN | System DSN | File DSM | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

MName Diriver - Add...
Licences Driver do Microsoft Acces:

_Hﬂ'nuve
Licences V& Driver da Microsoft para ai =
mysqlodbe MySQL ODEC 5.1 Driver
NRDOC S0L Mative Cliert
Report with breaks Microsoft Bxcel Driver ("
Support Management Driver do Microsoft Acces:
TestC5W Microsoft Text Driver (" i
4 | 1 | 3

An QDBC System data source stores information about how to connect to
the indicated data provider. A System data source is visible to all users
on this machine, including NT services.

=

[=T=7

0K || Cancel Apply Help

- Click OK and select the TestCSV system data source in the ODBC Data Source list:

ODBC Interface - Setup

ODBC Data Source s

Anadgrafica
AnagraficaZ
S BUGZILLA
Click and Decide to Excel
data derna ODBLC Setup
datademo
DataSelect Server Database 1.2
DrataS et Vizion C5Y
dBASE Filez
DrestEwcel
DSDE12C0
Ewcel Filez
Licences
Licerizes WE
M5 Access Databasze
myzglodbec

HNRDOC
Fieport with breaks E]

5 UEEnrt Manaiement

Advanced [use carefully, especially for server datasources)

Cancel

M
g

b anage Schema ¢ Mame levels

The ODBC Data Source should display as follow:
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ODBC Data Source

ODBC Interface - Setup E

Click&DECIDE NSI & BAI | KBA

O

| TestCgy

Cancel
]

Supparted Jain Style
@ Regular Only
) 5OLM00
() Access
() Oracle

(71 50L Server

TimeStamp format

4!

e

ODBLC Setup

[ {tg ‘wn-mm-dd HH: kM55

b anage Schema ¢ Mame levels

- Click OK
- Right click and select Test Connection

Advanced [use carefully, especially for server datazources)

=

Delete

Properties

Test Connedction

- Click OK

Click and DECIDE Administration Manager E

@ Connection was successful

- Start now Click&DECIDE Builder to run this Data Source against a temporary CSV file located in the
default C:\Program Files\Click and DECIiDE\BAI\Tempcsv.
- Make a new Query and select the Test_ ODBC_CSV data source:

Contact us: E-mail: sales@clickndecide.com Tel: +33 (0)6 71 99 86 60
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Login to Test_ODBC_CSV 5

. § zer 1D: IL]
SR Paszword: Cancel

- Enter no login and click OK
- Select atemporary CSV file

il Click and DECIDE - Query

File Edit WView Query Layout Tools Window Help

SH @R 4B Rl e @

:| Bugzilla Management.wfv _} Query v X
L_j Local Database » [ d7d281604268.csv
-1 Local SQL Server d7d400552425.csv
o3 b
.E] MySQL

L_j MetReport
L__j MetReport Web
L__j Secured SQL Server

- | sqlserver
E] SupportAndManagement |E
.4l Test ODBC_CSV

-E.'] testodboosy -
-
dPMO0SEZd sy
Mame | Type | Lef ~
Area WVarchar
Salezsman name Warchar
Amount Float 3

F_0358A820_034C9600 0 Integer
F_0358A820_034C9600_1 Integer
F_0358A820_034C9600_2 Varchar

C NIE2 AT N2ATNEAN 2 Tetmmar
a4 ] | P

4 - Tables . Query  SQL [

- Click the Run button (!)
- If you get no error, the Microsoft ODBC Text Driver is working fine.
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|Q.| .||| .grc,«| Name | Type | Lengthl 5ca|e| Descriptiﬂnl ~
= d7d400552425_csv 4
—_I—_l—ﬂ Ares Yarchar 255 0
—_I—_l—ﬂ Salesman name Yarchar 255 0
— | amount Float 15 0
— | F_03884820 034C9600.0  Integer 10 0
— | F_03884820_034C9600.1  Integer 10 0 -
— | F_03884820 034C9600 2 archar 255 0 +
| F_03534820 034C9600.3  Integer 10 0 3
Area Salesman name Amount F_0358A820 034C9600 0 F_0358A820 034C9600 1 =
1 MORTH-WEST Bill Raley EEa18.2 2 Bl
2 NORTH-WEST Bill Raley 232418 23 7
3 MORTH-WEST Bill Raley 27022 27 10
4  NORTHAWEST Bill Raley H2480 22 12
5  MORTHWEST Bill Raley TE2E9.6 26 B
6  MORTHWEST Bill Faley 2R0530 21 7
7 NORTHWEST Bill Raley 96124.6 28 10

- Incase of error, please send a print screen of this error to the Support Team.
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